MICROSOFT POWERPOINT
2008 (MAC)
INTERMEDIATE/ADVANCED FEATURES

Assignment to be complete before workshop 2

Part I: Design and Layout Tools
Working With Slide Masters 2
Repositioning, Resizing, Rotating & Cropping Objects 4
Using Layout And Image Editing Tools 6
Inserting Movie Files Into PowerPoint 7

Part II: Other PowerPoint Features
Adding Sound Files 8
Creating Hyperlinks And Action Buttons 8
Inserting Charts 9
Using Connectors 10
Using Custom Animation On Bullet Slides 11
Alternative Distribution Methods 13
Tips for Creating Mac-PC Compatible Presentations 14

Questions?
Helene Hoffman, PhD
Assistant Dean, Educational Computing
TEL: (858) 534-3656
EMAIL: hhoffman@ucsd.edu
WORKSHOP HANDOUTS http://meded.ucsd.edu/edcom/workshops/
**PREPARATION FOR CLASS**

Welcome to the intermediate / advanced class in Microsoft PowerPoint. Before class starts, please complete the exercise below. This presentation will be used as the basis for the rest of this session.

**Pre-Workshop Exercise - Create a new presentation**

a. Select presentation size appropriate for on-screen format.
b. Use slide layout menu from the elements gallery to create a title slide.
c. Use slide layout menu to create one or more bulleted text slides.
d. Insert an image or clip art file.
e. Compose speaker notes in the notes pane.

**PART I: WORKING WITH DESIGN & LAYOUT TOOLS**

**Employing Slide Masters**

A Slide Master, part of the PPT file info, stores:

- Placement of text and objects on a slide.
- Text characteristics (font type, size, color, etc.).
- Line spacing preferences.
- Background (theme, background graphics, etc).
- Special effects (shadows, bullet type, etc.).
- Placeholders for text, headers, and footers.

Presentation created using Slide Masters look more professional and (once you are familiar with the process) are easier to create. Slide Masters ensure consistency from slide to slide. They enable you to change the appearance of all slides (of a given layout) with a single change on the Slide Master. Slide Masters are also a handy way to add logos, footers, etc. to every slide.

While all slides in a presentation should have the same unifying theme (whether professional or home made), you can have “sub-masters” for any layout you frequently employ. PowerPoint provides layouts including the ones listed in the table below. Custom layouts can also be created.

<table>
<thead>
<tr>
<th>Title</th>
<th>Two columns of content</th>
<th>Contents with caption</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title and content</td>
<td>Comparisons</td>
<td>Title and vertical text</td>
</tr>
<tr>
<td>Section header</td>
<td>Blank</td>
<td>Vertical title and text</td>
</tr>
</tbody>
</table>
Even though you set up a Slide Master, not all slides have to follow it in every detail. On any individual slide, you can make changes to any element: the colors, textures, shading pattern, pictures, graphics, headers, footers, etc. You can also suppress the background graphics on any slide, if you so choose.

To open the Slide Master (choose either method):
- **Menu bar** -> View-> Masters -> Slide Master.
- **Shift-click** on the slide icon on the view menu at the bottom left of the screen (while on any slide in your presentation).

To close the Slide Master (choose one):
- **Menu bar** -> View-> Masters -> Slide
- **Click** on the slide icon on the view menu

The **format menu** (or **Formatting Palette**) contains most options needed to work on the Slide Master.

*Note: PowerPoint also offers a **Handout Master**, and a **Notes Master**. Each operates in a similar way to the **Slide Master** described in this section. To modify one of these Masters, select it from View menu.*

**Exercise I – Slide Masters**

1. Open the Slide Master for your presentation
2. Click on the top (big) Master slide icon
3. Select the text in the master title styles placeholder and make changes to the following:
   a. Font style, size, or color.
   b. Title alignment.
4. Select the text in the master text styles placeholder and make changes to the following:
   a. Font style, size, or color.
   b. Bullets.
   c. Line spacing.
5. Change the background color.
6. Add a footer, date, or page number (if you desire).
7. Experiment with the specific slide layouts in the Slide Master file. See what happens if you only change one layout.
8. Close the Slide Master.
Repositioning, resizing, rotating, layering, aligning, distributing & grouping

An object in PowerPoint can be clip art, photos, charts, tables, text, etc.

Some manipulations can be done directly to an object. Others require tools found in specific Formatting Palette.

**Repositioning** does not require any special tools.

1. Click on the object and the cursor changes to a **four-way arrow**.
2. Click-drag the object to the new position.

**Resizing:**

1. Approximation method
   a. Click on object. A **bounding box** appears.
   b. Place cursor over **circles** (corners) or **squares** (sidewalls). The cursor will change to indicate the direction in which the object will resize.
   c. Click-drag the bounding box to desired size.

2. Precise method
   a. Click on the object.
   b. Enter values for height and width in the **Size** portion of the Formatting Palette. (**Green Arrow**)

   *Note: Be sure to select the **lock aspect ratio** checkbox.*

**Rotating:**

1. Click on the object.
   a. Place your cursor over the green dot that appears at the top. It will change to a **rotate cursor** you can use to turn the object.
   b. Or use the **Rotation** menu from the Formatting Palette (**Red Arrow**)
2. When you are done, click outside the object.

**Layering:** The object most recently added to a slide is placed on top, the oldest at the bottom.

1. Select one or more objects on the slide.
2. Use the choices in the **Arrange** pull down menu in the Formatting Palette (**Orange Arrow**)
   a. Bring to Front
   b. Bring Forward
   c. Send to Back
   d. Send Backwards
The following actions are done using either the **Align** or **Distribute** menu of the Formatting Palette (see purple arrows in figure on previous page).

**Aligning** the edges of multiple selected objects:
1. Hold down shift key and click each object you want to select.
2. Click on the **Align** pull down menu.
3. Make sure **Align Selected Objects** is selected.
4. Choose **Align Left, Center, Right, Top, Middle, or Bottom**.

**Aligning** one or more objects relative to the slide:
1. Select the object(s).
2. Click on the **Align** pull down menu.
3. Make sure **Align to Slide** is selected.
4. Choose **Align Left, Center, Right, Top, Middle, or Bottom**.

**Distributing** with 3 or more objects to make them equally spaced (horizontally or vertically) with respect to each other:
1. Hold down shift key and click each object you want to select.
2. Click on the **Align** pull down menu.
3. Make sure **Align Selected Objects** is selected.
4. Choose **Distribute Horizontally** or **Distribute Vertically**.
5. This action keeps the outer objects stable and moves the inner ones for equal spacing.

**Distributing** with one or more objects to make them equally spaced across the slide:
1. Select the object(s)
2. Click on the **Align** pull down menu.
3. Make sure **Align to Slide** is selected.
4. Choose **Distribute Horizontally** or **Distribute Vertically**

**Group**: A collection of objects that behave as *one* for purpose of moving, resizing, or rotating them. A group can be composed of multiple sets of groups.
1. Select the objects
2. On the Formatting Palette, under size, rotation, and ordering: click grouping.
3. Select the command group, ungroup, or regroup.

**Exercise II - Manipulating Objects**
1. Take a few minutes to work with the objects in your presentation.
2. Try repositioning, resizing, layering, aligning, distributing, and/or grouping.
Using PowerPoint’s Image Editing Tools

When you click on an image, the Picture menu opens in the Formatting Palette (red outline).

Fine-tuning options:

1. Sliders
   a. Brightness.
   b. Contrast.
   c. Transparency.

2. The Recolor menu allows you to create grey scale, sepia, and colorize versions of your image.

3. Crop
   a. Click on the object.
   b. Select the crop tool.
   c. The cursor changes to a crop symbol.
   d. Drag the special frame edges of the picture until the desired effect is obtained.
   e. When done, click outside the image.

4. Shape.

5. Set Transparent Color

6. Replace picture with an alternative.

7. Special Effects.


9. Reset to original.

Image embellishments can be in the Quick Style and Effects menu (green outline) or by double clicking on the image and using the Format Picture menu. Options include:

1. Borders and frames
2. Drop shadows
3. Reflections
4. Three-dimensional effects

Exercise III - Image Editing and Layout

Take a few minutes to explore the variety of editing options and apply them to your images.
Inserting Movie Files

PowerPoint 2008 may /may not support a variety of movie formats. While they often claim to handle multiple file types, Motion Picture Experts Group (MPEG) files are the safest bet. Note: In our experience MPEG1 and MPEG2 file types are great, but MPEG 4 can be problematic.

Note: All inserted movies are linked to your presentation, unlike pictures that are embedded into the PowerPoint file. Therefore, care must be taken when inserting a movie or it will not work when you move the presentation to another computer. You must carry a copy of the movie with the PowerPoint presentation. Before you insert a movie (video file):

1. Make sure the presentation is located inside of a folder.
2. Find the movie and copy it to the same folder.

To insert a Movie

1. Select the file by either of these methods:
   a. From Standard Toolbar
      i. Click the Media pull down menu.
      ii. Select “Insert Movie …..”
      iii. Locate movie title in the file menu,
      iv. Click Choose.
   b. From Insert Menu bar, select movie, locate title in the file menu, and then click Choose.

2. A message will appear. Depending on your preference:
   a. Pick yes, to automatically play movie when you display the slide in a slide show.
   b. Pick no, to play movie only on mouse click.

3. To preview in the Normal View, double-click the movie.

To modify Movie options

1. Click on the movie and the movie options menu will appear on the Formatting Palette.
2. From here you can control the trigger, the audio volume, whether to rewind after playing, and many other options.

Exercise IV - Inserting movie files into your presentation:

1. Select one or more of the movies located on the Workshop folder located on the desktop of your computer. (Look inside a folder called “Media 4 PPT class” for a folder called “Movie files”).
2. Copy the file to the folder that contains your working presentation file and follow the instructions for inserting a movie.
3. If you have time, try to modify some of the movie options.
Adding Sound Files

You can insert sound files in the following formats including:

- Audio Interchange File Format (AIF, AIFF, AIFC)
- Microsoft Windows Waveform (WAV)
- MPEG Layer 3 Audio (MP3)
- Advanced Audio Coding (AAC): MPEG-4 Audio

Note: Some sound formats (such as MP3 and aif) and files with a file size larger than the size set in your Preferences, are not embedded in the presentation when you insert them. Instead, they are linked from a location on your hard disk or the Internet. If you move the presentation, make sure to move these sound files with it.

Before you insert an audio file, make sure the presentation is located inside of a folder, find the audio file, and copy it to the same folder.

The steps for inserting audio files are the same as video files. Once an audio file has been added to your slide, a speaker icon appears. It can be moved to any convenient location on the slide.

Additional options (including sound volume, looping until stopped, etc.) can be found in the sound menu. Remember, to see this menu in the Formatting Palette, you must click on the sound icon.

Creating Hyperlinks

1. Type & then highlight the text to be linked.
2. Use the hyperlink menu in the Formatting Palette to choose your options
   a. Link on mouse click
   b. Link on mouse over
3. Select the end point of your hyperlink
   a. Within the presentation
   b. Another PPT
   c. Another file
   d. A website (type the URL in the dialog box that appears)

Inserting Action Buttons

1. Open Slide Show menu and choose Action Buttons.
2. Select a **button** or choose **custom** and create one yourself.
3. Click on the slide where you want the button to appear.
4. The cursor will turn into an unfilled cross.
   a. Click somewhere on slide to get default size/shape button.
   b. Or drag across slide to draw button of a different size/shape.
5. The **action settings** dialog box should appear. If not:
   a. Right-click on **action button**, and then select **action settings**.
   b. Select **action settings** (under slide show).
6. Select **mouse click** or **mouse over**.
7. Select the **action on click**.
8. Modify (if needed) the action button’s shape, color, size, etc.

### Inserting Charts

PowerPoint 2008 uses **Excel** to create charts within the presentation.

1. On the **Insert** Menu, click **Chart**. The Elements Gallery opens to the **Charts** tab.
2. Click on a category, and then select the specific chart type you want to use.
3. Excel opens with a table of sample data.
4. Replace the sample data with your data or copy your data & paste it over the sample data.
5. The chart data is automatically saved with PowerPoint and cannot be saved separately in Excel.
6. Chart in Excel? Copy and **paste special** into PPT. Paste as “Microsoft Excel chart object”.

**Tips for working with charts:**

<table>
<thead>
<tr>
<th>Change number of rows and columns.</th>
<th>In Excel, rest pointer on lower right corner of selected area, then click/drag to desired size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reverse the way table rows and columns are plotted.</td>
<td>Click on chart. A <strong>Chart Data</strong> section will appear in Formatting Palette. Next to <strong>Sort by</strong>, click either <strong>row</strong> or <strong>column</strong>.</td>
</tr>
<tr>
<td>Add chart or axis titles.</td>
<td>Click on chart. A <strong>Chart Data</strong> section will appear in Formatting Palette. Look under <strong>Titles</strong> pop-up menu to select <strong>chart title</strong> or <strong>axis</strong>. Type title where indicated.</td>
</tr>
<tr>
<td>Display/format gridlines.</td>
<td>From <strong>Chart Data</strong> section of Formatting Palette, look under <strong>gridlines</strong>, select options.</td>
</tr>
<tr>
<td>Change scale and formatting of gridlines.</td>
<td>Click chart. Position mouse pointer over <strong>gridline</strong> until its name appears. Double click and a <strong>Format Gridlines</strong> dialog box will open.</td>
</tr>
<tr>
<td>Edit data in a chart already in PPT</td>
<td>Click chart. In the <strong>Edit</strong> pull down menu, select <strong>Edit in Excel</strong>...</td>
</tr>
</tbody>
</table>
Using Connectors

There are three types of connector lines to join objects:
1. Straight
2. Elbow (angled)
3. Curved.

Each comes with / without arrows at one / both ends. The elbow and curved connectors have yellow diamonds that can be used to modify their path. To move the line, hold onto the yellow diamond and click-drag.

These connectors can be accessed from the object palette section of the Formatting Palette. Click on all shapes, and then select lines and connectors from the pull down.

Select a connector from the menu. Then roll cursor over shape. A red connection sites appears. These points indicate where you can attach a connector.

When a connector is correctly attached to a shape, the connector site turns red. It is locked.

If you move objects joined by locked connectors, the lines stay attached to the object. This is only true while you are in the Normal View, designing your slide. Unfortunately it is not interactive during a Slide show.
**Custom Animation**

1. **Entrance:** To have bullets appear one at a time (on mouse click):
   
   a. Click anywhere inside **text box** of the **bullet** (or numbered) list; a **bounding box** will appear.
   
   b. Select **Custom Animation** from the Formatting Palette. It is the third button from the left.
   
   c. Click on the **Green Star** and select the **Entrance Effect**.
   
   d. A content placeholder (with green star) will appear. Click on the right pointing arrow to expand the list. Each of the bullet lines has its’ own green star (the icon for entrance).
   
   e. Make sure the effect starts **On Click** (green outline)
   
   f. There are other options (such as emphasis, speed, etc) that you can explore once you are comfortable with the basics.
   
   g. Press the **Preview** button (blue outline) and see how this works.

2. **Add (optional) Exit Effect:**
   
   a. Click on **Red Star** and select **fade** from the exit effects.
   
   b. Go down to the **Start:** pull down and pick **With Previous**.
   
   c. Expand the content placeholder (with a Red Star). You may have to scroll to see the whole list.

3. **PowerPoint** executes these directions in order.
   
   a. **Preview** the animation now.
   
   b. You will see each line appear (one at a time) followed by everything fading at once.
   
   c. That is not what you want.
4. The order of these directions must be changed. To do so, click on a line then use the **Up** and **Down Arrows** to weave the **red stars** in between the **green stars** to create the correct event order.
   
a. See the example on the left.

b. Or use this generic description
   
   1. Line 1 appears
   2. Line 2 appears
   3. Line 1 fades
   4. Line 3 appears
   5. Line 2 fades
   6. Line 4 appears
   7. Line 3 fades
   8. Line 5 appears
   9. Line 4 fades

c. Notice a few inconsistencies in the pattern.
   
   i. The sequence always begins with 2 lines appearing
   
   ii. Then every other line is **Entrance – Exit – Entrance**, etc.

   iii. Unless you want to end with all bullets off the slide, you will have an extra **Exit**. To delete this line, click on it and then click on the **X**.

5. This bullet slide animation was created using an **Entrance** and **Exit** effect. There are many other ways to do this. For example, instead of using the **Exit**, try something in the **Emphasis** menu such as changing font color. Then the bullet text would appear and when the next line appeared, the first would fade to another color (perhaps a grey or one with low contrast to the background).
## Alternative Distribution Methods

Accessed from the **save-as** menu:

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PDF</strong></td>
<td>PDF presentation will look the same on Mac and PCs. Presentation loses any interactive features (custom animation, hyperlinks, etc).</td>
</tr>
</tbody>
</table>
| **PowerPoint Package** | Automatically collects sounds, movies, and other *linked files* that are not *embedded* in the presentation and creates a new folder that contains all the linked files along with a copy of the presentation.  
                      | The **PowerPoint Package** is a copy of the *presentation* and its *linked files* – in a location specified. The original presentation and linked files are in the original location. |
| **Webpage**     | Can be run locally or published to the Internet. If you do not publish, it will still play with a browser and is handy for users that do not have the Microsoft Office applications. |
| **Movie**       | A self-running slide show that plays in **QuickTime**.                                                                                       |
| **e-mail**      | **PowerPoint** files can be sent as attachments via email. But be aware of file size that can be excessive.                                      |

### Slides as iPhoto pictures

- On the **file** menu, select **send to**, and then **iPhoto**.
- **New album name** box: *type a name for your collection of photos*.
- **Format**: *select jpg or png*
- **Slides**: *click all if you want to convert all the slides or Selected if you want to convert only selected slides*.
- To save the slides as pictures, click **Send to iPhoto**.
- Note: After the slides are saved as photos, you can import the photos into your iPod and use it to show your presentation as a slide show.
**Tips for improving Mac-PC compatibility**

- Save files in XML file formats & append extension
- Use common fonts (Arial, Verdana, Georgia, Times New Roman, Symbol)
- Fonts may render differently, so give them room
- Use TIFF, PNG, GIF, or JPEG images – no PICT files
- Don’t cut and paste images, use insert from file
- Avoid QuickTime movies, use MPEG1 or MPEG2
- Use tools built into PPT for graphs and tables

**III. Presentation Guidelines**

- See slides 26-33 of associated PPT